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ABSTRACT 

The Alzheimer’s Disease in today’s world is one of the most leading and progressively 

debilitating neurodegenerative diseases characterized due to the deposition of beta-amyloid 

plaques, and presence of tau tangles, and neuroinflammation. Although years of research have 

been put into finding out a cure for this progressive disease, very little success has been 

achieved, thus necessitating the need for new targets to be discovered. 

Triggering Receptor Expressed found on Myeloid Cells-2 (TREM2) has proven to be 

recognized as an important immunoreceptor which is expressed mainly on microglia innate 

immune cells which are found on the Central Nervous System (CNS) and they act as the brain's 

first responders to pathological stimuli. TREM2 acts as a vital regulatory receptor of microglial 

homeostasis by controlling various neuroprotective mechanisms such as phagocytosis of 

Amyloid-Beta deposits, regulation of neuroinflammatory processes, microglial 

survival/proliferation, and synapse preservation. There are many considerable evidence based 

on genetic studies and functional analysis which proves that a lack of function mutations or 

improper regulation of TREM2 signaling pathways results in poor phagocytosis, persistent 

neuroinflammation, and faster progression of Alzheimer's Disease (AD). In contrast to this, it 

also proves that enhancing TREM2 activity improves neuroprotective responses of microglial 

cells; hence, TREM2 is considered as an appealing candidate for pharmacological modulation 

to achieve disease modification therapies for AD. 

In light of the increasing attention paid to natural bioactive molecules as novel neurotherapeutic 

agents, this study explores the ability of naturally occurring plant polyphenols as potential 

TREM2 regulators. Epigallocatechin Gallate (EGCG), apigenin, curcumin, and resveratrol are 

widely recognized to possess potent natural reductive phytocompounds, inflammation 

suppressing effects, the ability to pass through the Blood Brain Barrier, and neuroprotective 

properties. 

By evaluating the molecular interactions between TREM2 and these polyphenolic compounds, 

a computational in silico approach employing molecular docking was adopted in the present 

study. The 3D crystal configuration of TREM2 (PDB ID: 5ELI) was derived from the RCSB 

PDB i.e Protein Data Bank and used as the macromolecular target. In Silico docking activation 

were stimulated to systematically Evaluate the binding energies, interaction patterns and 

structural complementarity of EGCG, apigenin, curcumin, and resveratrol within the TREM2 

binding site. 

The docking analysis revealed a distinct hierarchy of binding affinities among the four 

polyphenols. Apigenin exhibited the highest binding affinity of −8.6 kcal/mol followed closely 

by EGCG at −8.5 kcal/mol, indicating that both compounds form thermodynamically 

favorable, stable, and highly specific interactions with TREM2. The strong binding energies 

observed for apigenin and EGCG suggest their capacity to engage critical residues within the 

TREM2 active site through multiple non-covalent interactions, H-bond mediated stabilization, 

apolar molecular contacts, and van der Waals forces, thereby stabilizing the receptor-ligand 

complex. Curcumin exhibited a moderate binding affinity of −7.1 kcal/mol, indicating 

reasonable but comparatively weaker interaction, while resveratrol recorded the lowest binding 

affinity of −6.3 kcal/mol among the tested compounds, suggesting limited binding efficiency 

with TREM2. 

The superior binding affinities of apigenin and EGCG highlight their strong potential to 

modulate TREM2 receptor activity and, consequently, influence downstream microglial 
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functional responses central to AD pathology — most notably neuroinflammation regulation 

and amyloid-β phagocytic clearance. These findings suggest that both apigenin and EGCG can 

be taken as lead phytochemical scaffolds for the evolution of TREM2-targeted neuroprotective 

therapeutics. 

While the results of this in silico molecular docking study are preliminary in nature, they 

provide a robust computational foundation and mechanistic rationale for advancing these 

polyphenolic candidates into subsequent stages of experimental validation, including in silico 

binding, cell-based operative studies in microglial models, and ultimately in vivo preclinical 

investigations. Collectively, this study contributes meaningful insights into the therapeutic 

modulation of TREM2 signaling through natural polyphenols and paves new pathways for the 

advancement of effective, plant-based interventional strategies for Alzheimer's disease. 
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INTRODUCTION 

 

We know that Alzheimer's disease (AD) is the main form of dementia and is known to be one 

of the major public health challenges in this century. AD is a disease which is irreversible, 

progressively neurodegenerative, the part of our brain that is responsible for memory is 

affected, leading to an irreversible decline in cognitive function. This Alzheimer disease causes 

loss of memory, failure to comprehensive decision, thinking and learning, leading to 

individuals being unable to carry out daily activities that require independence. The disease 

was first described by a German psychiatrist, Alois Alzheimer in 1906. For decades it was 

thought that the disease only occurred in middle aged individuals, but in fact it is a disease that 

affects older people and is now recognized as the most common cause of age-related cognitive 

decline in the world.[1] 

Al International have reported that about 55 million people in the world who are suffering from 

with dementia worldwide. And about 60 million peoples are suffering from Alzheimer’s disease 

(AD) resulting to become an epidemic globally. The World Health Organization and 

Alzheimer’s Disease80 percent of them have Alzheimer’s disease. This number is expected to 

explode by 2050 to In India, according to the Dementia India Report, there are 5.3 million 

people with dementia and this number is expected to double in the next two decades putting a 

tremendous strain on patients, their families and healthcare systems across the country. 

In Alzheimer's disease, the clinical presentation follows a number of stages [13]. In the first 

stage, which is called the pre-clinical or pre-symptomatic stage of the disease, changes such as 

amyloid-beta (Aβ) plaques and neurofibrillary tau tangles form in the brains of individuals with 

Alzheimer's, usually a decade or more before symptoms become apparent. As the disease 

progresses to the stage of mild cognitive impairment (MCI), individuals with the condition 

experience small but noticeable decreases in their memory and cognitive function. In the fully 

established dementia stage, patients exhibit profound memory loss, disorientation, language 

deficits, changes in personality and behaviour, and ultimately a complete loss of independent 

functioning. 

Although over 100 years of intensive research have been conducted, till now there is still no 

cure for Alzheimer's disease, and available drugs so far have only a symptomatic effect. 

Immunotherapy strategies against amyloid-beta that have been developed more recently (such 

as aducanumab and lecanemab) have shown some ability to reduce amyloid levels, but their 

clinical effectiveness and safety are still up for debate (Chen et al., 2025; Zuo et al., 2021). This 

therapeutic void highlights the importance of the discovery and validation of new molecular 

targets and therapeutic approaches for AD. 

1.2 Biochemical Mechanisms Underlying Alzheimer's Disease 

There are few major features of AD but two major features of Alzheimer's disease have been identified: 

extracellular senile plaques, which mainly contain aggregates of amyloid-beta peptides, and 

intracellular neurofibrillary tangles (NFTs), composed of hyperphosphorylated tau protein. In addition 

to these classical features, recent research has led to the appreciation that the disease pathogenesis is a 

complex, highly interrelated and self-perpetuating process involving neuroinflammation, synaptic 

dysfunction, mitochondrial impairment, oxidative stress, and disrupted proteostasis. 

The amyloid precursor protein (APP) is sequentially cleaved by beta-secretase (BACE1) and gamma-

secretase enzyme complexes to form amyloid-beta peptides. In a healthy brain, soluble Aβ monomers 

are promptly eliminated from the brain via several pathways, such as enzymatic degradation, CSF 
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drainage, and receptor-mediated transcytosis across the blood-brain barrier. In the Alzheimer brain, this 

equilibrium is disturbed either by excess production of Aβ (as in familial early-onset cases caused by 

mutations in the APP, PSEN1 and PSEN2 genes) or by impaired clearance (as is dominant in the late 

onset sporadic form) resulting in progressive accumulation of oligomeric and fibrillar Aβ species that 

combine into mature plaques. 

In normal biology, tau protein is a cytoskeleton protein that wok as stabilizing agent for the cytoskeletal 

elements of the axons and their transportation machinery. In the pathological state of AD, there is 

abnormal hyperphosphorylation of the tau protein, to the detachment of microtubules and ultimately 

aggregation into NFTs via formation of paired helical filaments [15]. Pathological evolution of the tau 

protein follows a consistent pattern in the brain, first developing in the entorhinal cortex and 

hippocampus before moving to limbic and neocortex regions.  

Neuroinflammation has come to be recognized as a third central pathological feature of Alzheimer's 

disease, instead of being a minor epiphenomenon. Bra [1]sident innate immune cells called microglia 

constantly patrol the neural parenchyma. Microglia can be activated and trigger inflammatory responses 

in the context of Aβ deposition and neuronal injury, which may be beneficial and protective in the acute 

phase by facilitating the phagocytosis of amyloid and tissue repair. However, prolonged and chronic 

activation leads to a pro-inflammatory dysfunctional state of microglia, with the excessive production 

of cytokines (TNF-α), interleukin-1 beta (IL-1β) and interleukin-6 (IL-6)), reactive oxygen species 

(ROS) and antioxidant, which further contributes to neuronal injury and disease progression [5],[6]. 

1.3 TREM Cells 2: A Central Controller of Microglial Function in Alzheimer's Disease 

The TREM2 is one of the most important and promising targets discovered over the last ten years among 

the molecular pathways involved in microglial function in Alzheimer's disease. TREM2 is an 

immunoglobulin superfamily type 1 transmembrane receptor, mainly expressed by microglia in the 

CNS, and by peripheral myeloid cells like macrophages, osteoclasts and dendritic cells, [6],[7]. 

Two to four-fold risk variants in the TREM2 gene were discovered and in particular the R47H missense 

variant, which put TREM2 in the spotlight of the genetic research on AD [18]. This risk size is similar 

to the well-known genetic risk factor for sporadic Alzheimer's disease, the APOE4 allele, which 

indicates the crucial role microglial immune signalling plays in the ethology of the disease [7],[8]. 

TREM2 signals through its transmembrane adaptor protein DAPI12 kDa which contains an 

immunoreceptor tyrosine-based activation motif (ITAM). Ligands binding to the extracellular 

immunoglobulin-like domain of TREM2 recruit and activate Syk kinase through the activation of 

ITAMs that are phosphorylated by Src-family kinases; this activates downstream signaling pathways. 

These pathways together control a wide range of microglial activities, such as phagocytosis, 

chemotaxis, production of inflammatory cytokines, cellular metabolism, proliferation and survival 

[7],[8],[9]. 

TREM2 is involved in several critical protective activities in the context of Alzheimer's disease. It 

encourages phagocyte-mediated removal of amyloid-beta aggregates, apoptotic neurons, and cellular 

debris, and restricts propagation of amyloid-beta toxic protein aggregates. TREM2 also contributes to 

the metabolic fitness of DAM, a transcriptionally distinct microglial state that is associated with genes 

involved in phagocytosis, lipid metabolism and lysosome function that is observed in the vicinity of 

amyloid plaques and is thought to represent a protective adaptive response to Aβ deposition. Loss of 

TREM2 function impairs the shift into this DAM state, reduces amyloid clearance and causes chronic, 

unremitting neuroinflammation, accelerating neurodegeneration [8],[9],[19]. 

For these complex protective functions, TREM2 has been a target of interest in the field of Alzheimer's 

disease, and strategies to boost TREM2 signalling, to block the shedding of the TREM2 ectodomain (to 

generate soluble sTREM2) and to stabilize the TREM2-DAP12 receptor complex are currently being 

explored. Nevertheless, small molecule modulators of TREM2, especially of natural origin, are under-

studied and hold great potential for computational and experimental drug discovery efforts [9]. 
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1.4 Natural Polyphenols as Neuroprotective Agents 

Natural polyphenols are a huge and largely diverse group of plant secondary metabolites, which are 

defined by the presence of one or more phenolic hydroxyl groups in aromatic ring systems. To date, 

over 8000 polyphenolic compounds have been identified in the plant kingdom and these include 

flavonoids, stilbenes, phenolic acids, lignans, tannins, and others. The polyphenols are widely found in 

food and beverages such as fruits, vegetables, legumes, whole grains, tea, coffee, red wine and spices, 

and have been linked to a wide range of health benefits in many epidemiological and experimental 

studies . 

Polyphenols have been the focus of many studies in the context of neurodegenerative diseases due to 

their ability to act on several pathological mechanisms involved in Alzheimer's disease. These include 

powerful antioxidant activity by directly scavenging free radicals and induction of endogeneous 

antioxidant defense bio enzymes activity by modulation of NF-κB and MAPK signalling pathways, 

inhibition of Aβ aggregation and promotion of disaggregation of preformed fibrils, inhibition of BACE1 

and gamma-secretase activities, inhibition of tau hyperphosphorylation, modulation of autophagy and 

mitophagy, and the protection of synaptic structure and function [3],[4],[5]. 

Epigallocatechin-3-gallate (EGCG), apigenin, curcumin and resveratrol are some of the most widely 

studied phytochemicals with neuroprotective properties in various chemical classes. The most abundant 

and bioactive catechin in green tea (Camellia sinensis) is EGCG, which belongs to the subclass of 

flavonoids known as flavan-3-ols, and has been shown to have strong anti-amyloidogenic, anti-tau, 

antioxidant and anti-neuroinflammatory properties in many in vitro and in vivo models [3]. Apigenin is 

found in edible plants such as chamomile, parsley, and celery and is a flavone that crosses the blood 

brain barrier, regulates neuroinflammatory signaling and promotes neurogenesis in the hippocampus 

[4]. The rhizome of turmeric are found to contain curcumin, which has a number of properties that have 

been shown to reduce Aβ aggregation, disaggregate preformed fibrils, chelate metal ions that are 

thought to mediate Aβ toxicity and attenuate neuroinflammation [4],[5]. Resveratrol is a stilbene 

polyphenol present in grapes, red wine, berries, and peanuts that has been shown to activate SIRT1 

deacetylase pathways, to induce autophagic clearance of Aβ, and to exert anti-inflammatory and anti-

oxidative effects [4]. 

In spite of their promising multi-target neuroprotective activity, the clinical translation of these 

polyphenols in Alzheimer's disease has been limited by their pharmacokinetic drawbacks such as low 

aqueous solubility, low oral bioavailability, rapid metabolism and inadequate blood brain barrier 

penetration. However, they possess a wealth of biological functions and are proven safe for use, which 

renders them appealing targets for structure-activity relationship analysis and computational screening 

to discover specific molecular interactions with proven AD targets like TREM2 [3],[4],[10] 

1.5 Molecular Docking as a Computational Drug Discovery Tool 

The rational identification of drug candidates that interact favourably with a biological target of interest 

has been fundamentally transformed by the advent of computational methods in medicinal chemistry 

and structural biology. Of these, Insilco docking is one of the mostly used and powerful tools in the 

current drug discovery pipelines. Molecular docking is a computational simulation method which can 

predict the preferred binding position (pose) of a small ligand in the 3d binding position of a 

macromolecular target (receptor) and calculated free energy of binding associated with this orientation 

as a binding affinity or a docking score (kcal/mol) [11]. 

Docking algorithms proceed by systematically sampling the conformational space of a flexible ligand 

in a specified search space on the receptor, scoring the geometric and energetic fit between each pose 

of the ligand and the receptor, and ranking the poses based on the calculated binding affinity. The most 

common docking programs are AutoDock, AutoDock Vina, DOCK, Glide, GOLD, and FRED which 

use different algorithms for searching for binding sites and different scoring functions to determine the 

binding affinity. The platform used in the present study is AutoDock Vina, which is faster and more 

accurate than its predecessor AutoDock 4 [11] and uses a gradient optimization method to determine a 

docking pose and a sophisticated empirical scoring function that considers steric, hydrophobic and 

hydrogen-bonding interactions. 
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Molecular docking has several promising benefits in drug discovery for neurodegenerative diseases. It 

allows for screening of large compound libraries against a target of interest quickly and cost effectively 

and is used to prioritise the most promising candidates for experimental testing, thereby saving time 

and resources from traditional high throughput experimental screening. The information it provides is 

also invaluable in understanding structure-activity relationships and hit-to-lead optimization, giving 

atomic-level understanding and insights into the key non-covalent interactions that mediate ligand-

receptor recognition, such as conventional covalent and non-covalent bond.[11],[12]. 

In some Alzheimer's disease and neuroinflammation studies, molecular docking has given valuable 

insights regarding the potential interactions between natural compounds and known targets like 

acetylcholinesterase, BACE1, gamma-secretase, GSK-3β, HDAC, and, more recently, immune 

receptors such as TREM2. These computational investigations have shown the usefulness of in silico 

screening in the identification of polyphenols and other phytochemicals with favourable predicted 

binding characteristics, rational mechanism of action for their observed biological activity and the 

prioritisation of candidates for experimental follow-up [12],[21]. 

1.6 Objectives and Boundaries of the Present Investigation 

The overall goal of this dissertation is to systematically evaluate the binding properties of selected 

natural polyphenols to TREM2 in silico by molecular docking to find candidate natural polyphenols 

that may modulate TREM2 activity and thus potentially augment microglial mediated neuroprotection 

in AD. 

oUR study aims to: 

(i) To download and structure the three-dimensional crystal structure of TREM2 (PDB ID: 5ELI) for 

molecular docking. 

(iii) To select, retrieve and prepare the three-dimensional structures of four representative natural 

polyphenols (EGCG, apigenin, curcumin and resveratrol) as candidate ligands. 

(iii) To conduct molecular docking studies on each polyphenol compound in the TREM2 binding site 

using AutoDock Vina within PyRx virtual screening software to obtain the binding affinities and 

binding pose of each polyphenol compound in the binding site of TREM2. 

(iv) To analyse and visualise the obtained protein-ligand complexes in BIOVIA Discovery Studio 

Visualizer to find out the important non-covalent interactions and binding residues. 

(v) To discuss the docking results in the light of the TREM2 biology and Alzheimer's disease pathology 

and suggest a computational rationale for selecting certain polyphenols for experimental testing as 

TREM2 modulators. 

This study is limited to computational in silico methods, namely the molecular docking and does not 

include experimental laboratory validation. The findings are to be used to develop mechanistic 

hypotheses and prioritization frameworks that will inform future in vitro and in vivo experimental 

studies. The study only involves the four polyphenols with already established neuroprotective and anti-

neuroinflammatory effects, and the TREM2 crystal structure with PDB ID 5ELI, which represents the 

extracellular immunoglobulin-like domain of human TREM2 in a conformation appropriate for the 

docking analysis of the ligands. 
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CHAPTER 2  

Literature Review 

 

2.1 AD: Epidemiology, Etiology, and Pathophysiological Mechanisms 

AD is the main reason of dementia in the world and is the cause of about 60-80% of all dementia 

cases. The impact of the disease on the population is enormous and will keep increasing with 

the ageing of the global population. It that there are ~55 million people worldwide with 

dementia, and that this number will grow to 78 million by 2030 and 139 million by 2050. The 

total economic burden of dementia worldwide is estimated to be over one trillion USD dollars 

per year, including direct health care expenses, indirect costs due to informal care and lost 

productivity [1], [2]. 

There are two general categories of etiological forms of AD. The familial, early onset type (less 

than five percent of all cases) is due to autosomal dominant mutations in genes that encode the 

APP, PSEN1, and presenilin-2 (PSEN2), all of which lead to elevated levels of the 

amyloidogenic Aβ42 peptide. The sporadic and late onset type (the great majority of cases) is 

the result of complex interaction of a number of genetic susceptibility loci, as well as 

environmental factors, lifestyle and age-related biological changes. The epsilon-4 APOE4 is 

the most potent known genetic risk factor for sporadic AD, with a two- to three-fold increased 

risk in heterozygotes and an eight- to twelve-fold higher risk in homozygotes compared with 

the APOE3 reference allele [2], [1],[3],[17]. 

The neuropathological hallmark of AD is the progressive deposition of extracellular Aβ plaques 

and intracellular neurofibrillary tau tangles in specific brain areas, particularly in the 

hippocampus, entorhinal cortex, and association cortices, which result in a loss of synapses and 

neuroinflammation and ultimately in the death of neurons throughout the brain. The amyloid 

cascade hypothesis suggests that an abnormal accumulation of Aβ is the initial event in the 

pathogenesis of AD, leading to a cascade of events including tau pathology, synaptic 

dysfunction, neuroinflammation and neurodegeneration [14]. Although this concept has been 

the basis for most therapeutic approaches over the last 30 years, the failures of many anti-Aβ 

therapeutic strategies in recent clinical trials have led to a more general consensus that 

neuroinflammation, tau pathology, synaptic dysfunction, and metabolic abnormalities are all 

co-equal factors that need to be targeted [3],[5],[22]. 

Microglia, the innate immune cells of the brain, are the primary cells involved in 

neuroinflammation in Alzheimer's disease, in addition to astrocytes and infiltrating peripheral 

immune cells. The last ten years of GWAS have identified a remarkable number of AD risk-

loci within genes that are primarily or entirely expressed in the microglial immune system, 

such as TREM2, CR1, CLU, CD33, INPP5D, MEF2C and many others, confirming the idea 

that microglial immune signaling is a primary driver of AD risk and progression, not a mere 

secondary consequence of neurodegeneration [5,6,7]. 

 2.2 TREM2 in Neurodegeneration: Structure, Signaling, and Disease Relevance 

The TREM2 gene encodes a 230-amino acid type I transmembrane glycoprotein of the 

immunoglobulin superfamily found on chromosome 6p21.1. The protein has an extracellular 

immunoglobulin variable (IgV) domain that is involved in recognizing the ligand, a short stalk 
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domain, one transmembrane helix with a critical positively charged lysine for binding to the 

negatively charged DAP12 adaptor, and a short cytoplasmic tail [7],[8]. 

Structural studies of TREM2 by X-ray crystallography and cryo-electron microscopy have 

greatly facilitated the understanding of TREM2 function. The crystal structure of the human 

TREM2 extracellular domain (PDB ID: 5ELI) shows that the structure is a classical IgV-fold 

with a conserved disulfide bond with a positively charged surface that is expected to bind 

negatively charged lipid ligands and phospholipid-associated proteins that aggregate during 

neurodegeneration. Structural studies have shown that the major ligand binding interface is a 

hydrophobic groove with adjacent charged patches, which has been an important basis for 

computational docking investigations [7,8,9]. 

The ligands for TREM2 discovered so far are a wide range of molecules that reflect the 

receptor's function in detecting and reacting to cellular damage and lipid dysregulation during 

neurodegeneration. These include soluble oligomeric forms of Aβ, apolipoprotein E, clusterin, 

sulfated glycosaminoglycans, low density lipoprotein (LDL) and very low-density lipoprotein 

(VLDL), and phosphatidylserine and phosphatidylethanolamine exposed on apoptotic cell 

membranes [8],[9]. The diversity of these ligands indicates that TREM2 is a pattern recognition 

receptor involved in monitoring the lipid microenvironment and metabolic status of the brain 

parenchyma. 

The cellular effects of the TREM2 signaling pathway have been well characterized in the 

context of Alzheimer's disease. Under trophozoid deprivation conditions, functional expression 

of TREM2 signaling can prevent microglial cell death through the activation of the PI3K-Akt-

mTOR pathway and the inhibition of apoptosis. It increases the phagocytosis of microglia, 

leading to better internalization and degradation of Aβ aggregates and apoptotic neurons in the 

lysosomes. It facilitates the shift of microglial metabolic pathway to oxidation phosphorylation 

and fatty acid oxidation necessary for maintaining the energy-intensive disease-associated 

microglial state. Additionally, TREM2 signaling regulates inflammatory cytokine release, 

which typically leads to a more anti-inflammatory microglial phenotype that helps prevent 

collateral neuronal damage [8],[9]. 

In contrast, loss-of-function mutations of TREM2, ectodomain shedding by the 

metalloprotease ADAM10 and a lack of engagement with ligands have all been shown to have 

a spectrum of negative effects which are variously manifested as decreased clustering of 

microglia around amyloid plaques, decreased amyloid compaction or clearance of Aβ, 

increased neuritic dystrophy around plaques, increased inflammatory signaling, and increased 

neurodegeneration. Consistent with this, Trem2 is genetically deleted in mouse models, leading 

to enhanced amyloid pathology, decreased disease-associated microglia, and impaired 

cognition [7],[8],[9]. 

Several lines of evidence reinforce the translational importance of TREM2 in human AD. In 

addition to the genetic risk associated with R47H, R62H, and other coding variants, soluble 

TREM2 (sTREM2) in the CSF has been shown to be a marker of microglial activation and 

disease progression, and to increase with tau pathology and be correlated with clinical 

deterioration. Zhang et al. (2025) performed a detailed systematic review of TREM2 and 

sTREM2 in Alzheimer's disease, finding that sTREM2 is a dynamic biomarker of microglial 

reactivity to amyloid and tau pathology and that interventions that increase TREM2 signaling 

hold promise as disease modifying interventions [1]. In a second review, similarly performed 

by Yin et al. (2024), the importance of TREM2 in the regulation of neuroinflammation, 

phagocytosis and microglial survival was reiterated, with genetic, transcriptomic and 

proteomic evidence supporting a role of TREM2 in the progression of AD [2]. 
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2.3 Natural Polyphenols in Alzheimer's Disease: Mechanisms and Evidence 

Over the last 20 years, there has been a compelling body of epidemiological, preclinical and, 

increasingly, clinical evidence that suggests dietary and plant-derived polyphenols could 

provide some degree of neuroprotection against Alzheimer's disease. Several epidemiological 

studies have reported negative relationships between the consumption of polyphenol-rich 

dietary patterns, such as the Mediterranean diet and its variations, and cognitive decline and 

dementia in elderly people. These led to extensive mechanistic studies of specific polyphenolic 

compounds and their molecular targets and biological activities in models of AD 

[3],[4],[10],[20]. 

2.3.1 EGCG 

They are mostly in green tea is EGCG and the most widely studied anti-Alzheimer polyphenol. 

Chemically EGCG (C22H18O11, molecular weight 458.37 g/mol) is a flavan-3-ol which is 

esterified with gallic acid and contains several catechol and galloyl hydroxyl groups 

responsible for its high antioxidant and metal-chelating properties. EGCG has been found to 

disrupt the secondary structure of Aβ, specifically by disrupting beta-sheet structure, to 

disaggregate preformed Aβ fibrils, to chelate transition metal ions (copper, zinc, iron) that are 

known to be involved in Aβ oligomerization, and to inhibit BACE1 activity [3],[4]. 

EGCG is found to stop the working of NF-κB, and cause the decrease expression of COX-2 

and iNOS , and stop the production of TNF, IL-1beta and IL-6 in cellular and animal models. 

Vicente-Zurdo et al. (2024) performed a thorough analytical review of polyphenols for their 

neuroprotective properties, summarizing the multi-target activity profile of EGCG, including 

the inhibition of amyloid, anti-tau, antioxidant, and anti-neuro-inflammatory properties [3]. 

Dietary supplementation with EGCG has been shown to decrease amyloid plaque burden, 

decrease levels of neuroinflammatory markers, and improve cognitive deficits in behavioral 

paradigms in several studies using APP/PS1 and 3xTg-AD transgenic mouse models [3, 4]. 

2.3.2 Apigenin 

Apigenin is one of the flavones present in high concentrations in the flowers of chamomile, but 

also in parsley, celery and many other edible plants. Apigenin has been the subject of much 

research in the field of Alzheimer's disease because of its unique pharmacokinetic 

characteristics compared to other polyphenols, such that it can cross the blood-brain barrier, its 

metabolic stability and its low toxicity profile [4]. 

Apigenin has a number of mechanisms of action for its anti-neuroinflammatory activity, 

including effects on NF-κB and MAPK/ERK signaling ways, as well as blocking microglial 

activation markers. A review by Özge Şahin et al. (2025) reported that apigenin has been shown 

to have neuroprotective properties in neurodegenerative diseases, suggesting that its multi-

target activity and anti-neuroinflammatory and anti-amyloidogenic effects render it a promising 

therapeutic agent [4]. In particular, apigenin has been shown to regulate microglial function 

and inflammatory signaling pathways, making it a promising candidate for further study as a 

potential TREM2 modulator. 

2.3.3 Curcumin 

Turmeric (Curcuma longa) is a spice that has been used for centuries as medicine, and curcumin 

is the primary polyphenolic pigment found in turmeric. Curcumin has received extensive  
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preclinical studies and a few clinical trials and has been one of the most widely studied 

polyphenols Alzheimer's disease studies [4],[5]. 

Curcumin's anti-Alzheimer mechanisms are very wide-ranging. It directly binds to and inhibits 

the aggregation of both Aβ and tau, disaggregates preformed Aβ aggregates, chelates metal 

ions, inhibits BACE1 and gamma-secretase activity, activates Nrf2-mediated antioxidant 

responses, and has potent antioxidant effects by stopping NF-κB, AP-1 and STAT3 signaling 

pathways. In particular, Chen et al. (2025) performed a detailed review on the polyphenols such 

as curcumin for Alzheimer's disease, which included a comprehensive analysis of molecular 

and therapeutic mechanisms based on in silico data [5]. Even with these promising preclinical 

characteristics, the clinical use of curcumin has been limited by very polarity, low oral 

bioavailability and rapid metabolic inactivation that has led to the development of interest in 

the formulation of curcumin into nanoparticles and the development of structural analogues 

that have better pharmacokinetic properties [4],[5]. 

2.3.4 Resveratrol 

Resveratrol is a stilbene polyphenol that is synthesized by many plant species as a defense 

mechanism against stress, injury and pathogen attack, and is especially rich in the skin of red 

grapes, red wine, berries and peanuts. The involvement of resveratrol in the start of the NAD-

dependent deacetylase SIRT1, a central control point for cellular metabolism, stress response 

and longevity pathways, is the primary reason for the extensive research into its role in anti-

aging and other diseases related to health. 

In AD models, resveratrol has been shown to have neuroprotective properties by inducing 

deacetylation and activation of SIRT1, which leads to the removal of misfolded tau and the 

clearance of Aβ oligomers by autophagy. It also has an effect on AMPK signaling, inhibits the 

activation of NF-κB and NLRP3 inflammasome, prevents mitochondrial dysfunction, and 

regulates APP processing to decrease Aβ production. Resveratrol, as modulators of 

neuroinflammation and neurodegeneration in Alzheimer's disease and its capacity to regulate 

microglial activation states and inflammatory signaling networks [10]. In mild to moderate AD, 

clinical trials of resveratrol have shown to be generally safe and well-tolerated, with some 

evidence of its effects on CSF Aβ40 levels and neuroinflammatory biomarkers, but efficacy 

outcomes have been inconsistent [4],[10]. 

2.4 Molecular Docking in Neuropharmacology: Methods and Applications 

The molecular docking technique has become an indispensable tool in drug discovery for 

neurodegenerative diseases, allowing the identification of lead compounds and mechanistic 

characterization of interactions between these compounds and disease-relevant protein targets, 

in a rapid and cost-effective way. The methodological framework of molecular docking 

involves three related computational problems: the conformational and positional search 

algorithm for samples; the scoring function that assesses and ranks samples; and the protein 

representation that captures the structural features that are important for ligand binding 

[11],[12]. 

Developed at the Scripps Research Institute by Trott and Olson and published in 2010, Auto 

Dock Vina is based on an iterated local search global optimizer, a gradient optimizer for pose 

refinement, and an empirical scoring function that is calibrated using experimental protein-

ligand co-crystal structures and binding affinity data. The scoring function predicts binding as 

a combination of steric (repulsive/dispersive) and hydrophobic and hydrogen bonding  
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components in kcal/mol, with more negative scores predicting stronger binding [11]. In this 

present study, the program PyRx was used as a graphical interface of AutoDock Vina which is 

a platform for 3D protein preparation, docking and analysis of docking results, thus 

significantly decreasing technical barriers to HTS-VS [11]. 

A key issue is whether the molecular docking predictions are valid or not, which relies heavily 

on the quality of the input protein structure, the completeness and accuracy of the ligand 

preparation (including the appropriate protonation states and torsional definitions), and the 

selection of an appropriate search space (grid box) that covers the biologically relevant binding 

site adequately. For proteins with poorly defined binding sites from experimental data, blind 

docking over the whole protein surface (as used here) is an unbiased method for determining 

the preferred binding site [11],[12]. 

Comprehensive characterization of the interactions like non covalent bond between ligand and 

receptor in top-ranked docking poses is possible after post-docking analysis in visualization 

software like BIOVIA Discovery Studio Visualizer. These interactions involve conventional 

hydrogen bonds, carbon-hydrogen bonds, hydrophobic contacts, van der Waals interactions, 

pi-cation (aromatic rings with positively charged residues) interactions, pi-pi stacking (face-to-

face and T-shaped) interactions and halogen bonds, all of which add differently to binding 

affinity and selectivity [12]. 

Within the field of TREM2 and neuroinflammation research, Ulland and Colonna (2020) 

reviewed TREM2's role in microglial biology and in the context of Alzheimer's disease, 

elaborating on TREM2's structural and functional role as a druggable target and discussing 

ways to modulate its function in the context of AD [7]. It was extensively reviewed the 

physiology, pathology and therapeutic potential of the TREM2 signaling pathway, offering 

mechanistic support for targeting TREM2 in neurodegeneration [8]. In AD mouse models, 

showed that pharmacological modulation of TREM2 activity alters microglial responses and 

amyloid pathology, supporting the concept of TREM2 as a modifiable therapeutic target [9]. 

Computational docking studies have been conducted previously to gain insight into the 

interactions of natural compounds with TREM2; however, the field is still in its early stages. 

We found that both investigated the molecular mechanisms and in silico data for polyphenols 

as neuroprotective agents in Alzheimer's disease, providing insights into the role of docking in 

understanding protein-ligand interactions and predicting bioactivity [3],[4]. In the context of 

Alzheimer's disease, specifically investigated polyphenolic compounds with the support of in 

silico methods, which is closely related to the computational methods used in the current study 

[5]. Together, these publications present the scientific justification and methodological 

precedent for the in-silico assessment of natural polyphenols as TREM2 modulators carried out 

in this dissertation. 

2.5 Gap Analysis and rationale for the present study.  

Although the pathological importance of TREM2 dysfunction in AD has been well established, 

and the neuroprotective role of polyphenolic compounds has been corroborated by numerous 

publications, the interaction between molecules like polyphenolic compounds and the TREM2 

protein have never been systematically characterized by computational docking analysis. 

Previous molecular docking investigations of polyphenols for AD have been mostly directed 

toward the classical enzymatic targets (acetylcholinesterase, BACE1, and GSK-3β), and with 

only a few studies targeting immune receptor targets (TREM2) [3],[4],[5]. 

In addition, although the genetic and functional evidence for TREM2 as a primary regulator of 

risk and progression of Alzheimer's disease is undeniable, and several biopharmaceutical 
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strategies to enhance TREM2 signaling are in the preclinical and early clinical development, 

the possibility of naturally occurring small molecules that can modulate TREM2 function 

remains unexplored. Given the multi-target neuroprotective properties, the excellent safety 

profiles, brain permeability, and anti-neuroinflammatory effects of natural polyphenols, this 

class of compounds is an interesting group of potential TREM2 modulators that should be 

explored systematically using computational tools [7],[8],[9]. 

To fill this gap, the present study aimed to systematically analyze the molecular docking of 

four representative polyphenols (EGCG, apigenin, curcumin, and resveratrol) with the TREM2 

crystal structure using both binding affinity and binding pose as criteria, as well as to identify 

major interacting residues and to interpret the results in the light of TREM2 biology and 

Alzheimer's disease pathogenesis. The results will be used to offer a mechanistic computational 

reason for prioritizing candidate polyphenols to be further validated through experimental 

testing in cell-based and animal models of Alzheimer's disease.   
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CHAPTER 3 

METHODOLOGY 

This study utilizes molecular docking to evaluate the binding interactions between TREM 2 

and a panel of commonly used Natural plant-derived polyphenols for example epigallocatechin 

gallate (EGCG), apigenin, curcumin, and resveratrol to predict their potential to stabilize IL-

11 through favorable interactions. Here, we used PyRx for virtual screening of multiple 

excipients (ligands) targeting TREM 2. The following paragraphs detail the approach utilized 

for ligand selection, protein preparation, molecular docking, and validation procedures. 

3.1 How to retrieve protein and preparation   

• The 3D TREM2 was retrieved   From the AlphaFold Protein structure Database. The predicted 

structure was produced from the AlphaFold2 deep learning model created by DeepMind and 

EMBL-EBI.  

• The prediction confidence for every residue was eliminated using the pLDDT scores 

provided. Regions with low confidence were visually checked and, if necessary, were removed 

from docking studies to maintain the reliability of interaction predictions.   

• We will use Auto Dock Tools, and all water molecules and heteroatoms were removed. We 

will also assigned Polar hydrogens and Gasteiger charges. The protein was stored in PDBQT 

format for docking. 

 

Fig 3.1: Screenshot showing loading of protein in Auto Dock 4.0 
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Fig 3.2: Screenshot showing protein after modification 

1. Download the ligand  

Visit PubChem at www.pubchem.ncbi.nlm.nih.gov.  

• 3D Structures of EGCG, Apigenin, Curcumin, Resveratrol, were fetched from PubChem 

(https://pubchem.ncbi.nim. nih.gov/in) in SDF format and were converted into PDBQT format 

using Auto Dock Tools.  

• Geometry optimization and torsion tree definitions were applied to prepare flexible ligand  

2.Performing docking using pyrx  

Auto dock Vina will be the docking tool that we use. We use the Vina algorithm to dock it in 

Pyrx. Launch Pyrx GUI and followed the steps given below:  

2.1Protein Loading  

• Select "File" -> "Load Molecule" or simply click the first icon in the upper left corner. Choose 

the protein structure that you downloaded. referred to here as "TREM 2"  

• Convert pdb format of protein to pdbqt by right clicking on TREM 2 then on display and now 

select macromolecule. 
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Fig 3.3 Screenshot showing conversion of protein file pdb to pdbqt 

 

Fig 3.4 Conversion of protein file pdb to pdbqt 

2.2 Ligand loading  

• In PyRx, click on OpenBabel and select on insert new item present on bottom right corner.  

• Now select each ligand from folder one by one and upload it. 
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Fig 3.5: Screenshot showing loading of ligands 

• After uploading all ligands, right click on ligand and select minimize all to decrease the energy. 

 

Fig 3.6: Screenshot showing minimization of energy of ligand 

• Again, right click and select convert all to AutoDock ligand (pdbqt) to convert all ligands to 

pdbqt format. 
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Fig 3.7: Screenshot showing conversion of all ligands to pdbqt 

3. Defining ligands and proteins  

The loaded protein and ligand are shown under the "Molecules" tab. It is now necessary to 

identify which is a ligand and which is a protein. • Right-click on the protein –> “Autodock” > 

“Make Macromolecule” to accomplish that. Perform a right-click on the ligand, select 

"Autodock," then "Make Ligand."After that, you'll see that it has automatically prepared their 

PDBQT files under the 'Autodock' page. 

 

Fig 3.9:  Screenshot showing grid box 
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4 .Defining grid box 

• Now click on Vina Wizard and select start option on bottom right corner. Start selecting 

protein and ligand one by one by pressing shift and control button.  

• Click on forward. Grid box appears. Return to the 'Molecules' tab located on the right-hand 

side. Click the loaded protein's "+" symbol.  

• All of the residues in the chain will be visible to you. To choose the binding residues, right-

click on the residue and choose Atoms, Display, Label, and Atoms. The atoms will start to show 

up on the protein. Now make the appropriate adjustments to the grid box so that it contains all 

of the selected residues. The ligand does not need to be enclosed within the grid box. 

5 .Running vina for docking  

• To adjust the exhaustiveness, simply enter the desired number in the box located in the left 

bottom corner. Once everything has been adjusted, press the "Forward" button.  

• Docking will begin, and the processing will be shown. The bottom panel will display the 

poses and their binding affinities after the docking process is complete. It will show all poses 

along with RMSD values. Save your file in excel sheet.  

• Now analyze the result and the one ligand which has the highest energy with negative sign is 

selected. Again, open pyrx tab and click on Auto Dock and select macromolecule and select 

the ligand with highest binding energy. Now right click and select display then all models of 

the ligands get displayed and select your desired model and save it in pdb format. 

 

 

Fig 3.10: Screenshot showing running of vina wizard 

6. Open Discovery Studio: -  

Start a new project in Discovery Studio.  
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7. Protein Structure Import:  

• Open Discovery Studio and import the structure of the target protein.  

• Choose your protein structure file (such as *.pdb) by using File > Open. 

 

Fig 3.10: Screenshot showing visualization of protein structure in discovery studio 

 

8. Import Docked Ligand Conformations:  

• Import the docked ligand conformations.  

• Use File > Open and select the converted ligand file (e.g., *.pdb or *.mol2). 

9 .Visualize Docked Poses:  

• Display the protein and ligand together in the 3D workspace.  

• Use the View > Sequence panel to ensure the correct structures are loaded.  

• Adjust the display settings to show interactions clearly (e.g., stick or surface representations). 
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Fig 3.11: Screenshot showing EGCG binding with TREM 2 

10. Analyse Binding Affinities:  

• Check the binding affinities associated with each docked pose.  

• This information can be found in the PyRx log files or the output summary from PyRx.  

• Record the binding affinity scores (typically in kcal/mol) for reference.  

11. Examine Binding Interactions:  

• Use the Analyze > Receptor-Ligand Interactions tool to identify and visualize key interactions 

between the ligand and the protein.  

• Highlight hydrogen bonds, hydrophobic interactions, salt bridges, and π-π stacking  

interactions. Check for consistency with known binding sites or important residues in the  

binding pocket. 

12 .Evaluate Docked Poses:  

• Compare multiple docked poses to determine if there is a consensus binding mode.  

• Use the View > Compare tool to overlay different conformations and evaluate their  

similarity.  
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CHAPTER 4 

RESULT 

The binding affinities (kcal/mol) between TREM 2 and various natural plant polyphenols are  

summarized in the table below: 

RESULTS 

EXCIPIENT BINDING ENERGY (kcal/mol) 

Apigenin -8.6 

EGCG -8.5 

Curcumin -7.1 

Resveratrol -6.3 

 

Table 1: Binding Energies of TREM2 with selected excipients 

 

Fig 4.1: Screenshot showing Binding Affinities 

These results indicate that Apigenin exhibited the strongest binding to TREM 2, closely 

followed by EGCG and Curcumin. In contrast, Resveratrol displayed weaker interactions, 

suggesting a reduced potential for stabilizing the protein.  
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Molecular docking showed that Apigenin(–8.6kcal/mol), EGCG (–8.5 kcal/mol), and had 

stronger binding affinities with TREM 2 compared to Curcumin (–7.1kcal/mol) and 

Resveratrol (–6.3 kcal/mol). Polyphenols formed multiple hydrogen bonds with key TREM 2 

residues, suggesting better surface interaction and potential stabilizing effects.  
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Docking of different excipients with TREM 2 

Docking of TREM 2 with EGCG 

 

 

Figure 1: 2D and 3D structures of the TREM2–EGCG complex. EGCG binds with TREM2 

through a Pi–Cation bond (ARG122) and a Pi–Sigma interaction (VAL). Several 

hydrophobic interactions, including Pi–Alkyl interactions (PRO), also contribute to the 

stabilization of the complex. In addition, conventional hydrogen bonds with THR residues 

further support the stability of the complex, suggesting a good fit of EGCG within the 

binding pocket of TREM2. 
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Docking of TREM 2 with Apigenin 

 

 

Figure 2: 2D and 3D structures of the TREM2–Apigenin complex. Apigenin interacts with 

TREM2 through Pi–Cation interactions (ARG47, ARG122) and a Pi–Sigma interaction 

(VAL64). Several hydrophobic interactions, including Pi–Alkyl interactions (PRO59), also 

contribute to the stabilization of the complex. A conventional hydrogen bond with ASN 

residues further supports ligand binding, while an unfavorable acceptor acceptor interaction 

with TRP residues is also observed. These interactions suggest that Apigenin fits well within 

the binding pocket of TREM2, contributing to the overall stability of the protein–ligand 

complex. 
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Docking of TREM 2 with Curcumin 

 

 

Figure 3: 2D and 3D structures of the TREM2–Curcumin complex. Curcumin interacts with 

TREM2 through conventional hydrogen bonds (ASN residues), which contribute to 

stabilizing the ligand within the binding pocket. In addition, a Pi–Anion interaction (ASP) 

and an Amide–Pi stacked interaction (PRO) are observed, further supporting the stability of 

the complex. These interactions suggest that Curcumin fits well within the binding pocket of 

TREM2, contributing to the formation of a stable protein–ligand complex. 

 

 

 

 



33 
 

Docking of TREM 2 with Resveratrol 

 

 

Figure 4: 2D and 3D structures of the TREM2–Resveratrol complex. Resveratrol interacts 

with TREM2 through conventional hydrogen bonds (TRP and PHE residues), which help 

stabilize the ligand within the binding pocket. In addition, a Pi–Sigma interaction (PHE) 

and a Pi–Pi T-shaped interaction further contributes to the stabilization of the complex. A 

Pi–Anion interaction with ASP is also observed, suggesting that Resveratrol fits well within 

the binding pocket of TREM2 and forms a stable protein–ligand complex. 
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CHAPTER 5 

DISCUSSION 

TREM2 has emerged as a cornerstone in the modern understanding of AD pathogenesis. As a 

transmembrane glycoprotein primarily expressed on microglia, TREM2 serves as a vital sensor for the 

brain's microenvironment, orchestrating the transition of microglia into a "disease-associated 

microglial" (DAM) state. From this study we can reinforce the hypothesis that TREM2 is a crucial 

microglial receptor involved in regulating neuroinflammation, the phagocytosis of amyloid-β (Aβ), and 

microglial survival. As reported in literature, impaired TREM2 signaling disrupts microglial activation 

and reduces the clearance of Aβ plaques, which leads to sustained inflammation and accelerated 

neurodegeneration. Consequently, targeting this receptor to enhance microglial metabolic fitness and 

support the transition to protective phenotypes is a significant therapeutic strategy. In the present 

molecular docking study, the interactions of four natural phytochemicals epigallocatechin gallate 

(EGCG), apigenin, curcumin, and resveratrol—with the TREM2 receptor (PDB ID: 5ELI) were 

evaluated. The computational analysis revealed that Apigenin and EGCG exhibited the highest binding 

affinities, recorded at −8.6 kcal/mol and −8.5 kcal/mol, respectively. These values suggest significantly 

stronger and more stable interactions within the receptor’s binding pocket compared to Curcumin (−7.1 

kcal/mol) and Resveratrol (−6.3 kcal/mol). The thermodynamic stability indicated by these binding 

energies suggests that Apigenin and EGCG possess the requisite structural complementarity to 

effectively associate with the V-set immunoglobulin domain of TREM2, which is critical for ligand 

recognition and subsequent immune signaling. The selection of these specific ligands was predicated 

on their well-documented cytoprotective, anti-inflammatory, and neurorestorative properties. Recent 

evidence suggests that polyphenolic compounds can modulate neuroinflammatory pathways and 

attenuate amyloid associated toxicity in various AD models. Our docking results provide a specific 

mechanistic layer to these general neuroprotective effects, suggesting that Apigenin and EGCG may 

exert them benefits, at least in part, by directly interacting with TREM2-associated pathways. Such 

interactions could potentially influence microglial functions relevant to AD pathology, such as 

increasing the rate of Aβ clearance and controlling chronic neuroinflammation. Although these findings 

are based on in silico computational analysis, they provide a robust mechanistic rationale for prioritizing 

Apigenin and EGCG for further experimental validation. From the high binding affinity and stability 

we get from doing this study suggest these compounds are promising candidates for therapeutic 

modulation of TREM2 activity. Overall, this experiment supports the potential of natural 

phytochemicals as effective modulators of microglial receptors and highlights the importance of 

molecular docking as a preliminary screening approach for identifying candidate compounds capable 

of altering the progression of Alzheimer’s Disease. 
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